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1. CPU315-2 DP &' 5% UDP HEfE

AR IFITET]F 300 ¥ 455 PECS000 i DL B S I, S5HH CP 343
PIOK M, K uDP il fEiX, MM FCs A Fee .

1.1 2% E

1.1.1 k&

(1). BECAE step BT 300 9 LFE, & 1.1.1 Fios.

New Project @
User projects lLibr:aries ] Multiprojects
Hame | Storage path ~
%Dabl:l C:%"Program FileshSiemensiStepTheTpr
%123455 C:%Program FileshSiemensiStepTheTpr
£ 123458759 C:%Program Filez\SiemenzhStepTi=Tpr
£ 1234587591 C:%Prozram Files'SiemenshStepThsTpr
%258 C:\Program Files'Siemenz'StepThsTpr
%EEE\EE C:hFrogram Files"xSiemens"xStepT"xsTprY
< | ¥
r
Hame: Type:
|smpale_iudp |Pr-:-_ie-:t ﬂ
[
Storage location
|C: "Frogram Files'SiemenzhStepTisTproj Browse. .. |

Cancel | Help |

1.1.1 Fr TR

(2. midhiffiE)a, 2 MNP TR, AFKEIA smpale_udp, 41
& 1.1.2 BioR.



.! SINATIC Manager — [smpale ndp — C:%

%Eile Edit Insert PLC View Options Window
D & | 80 0 % 2
D R Object name
BENET (1)

1.1.2 T4

(3D B RARIAE LREA b, AdAEE, £ PR HIXE FIEFE Insert New
Obiect->SIMATIC 300 Station, 2= 8 st PUJ5 , 2 HIL—> 300 &k WA 1.1.3
I

w | Dbiect name Symbolic name

Inzert Hew Object SIMATIC 400 Statien
PLC 4 SIMATIC 300 Station

SIMATIC H Station
SIMATIC PC Statien
Other Station
SIMATIC 35

FiG/FC

Rename Fz
Object Froperties... Alt+tRetwrn

MPI

PROFIBUS

Industrial Ethernet
FTF

ST Frogram
MT Frogram

+ % smpale_udp Object name - % smpale_udp Object name

..........................

eI (1) SIMATIC 30001 Har dwar e
5

..........................

1.1.3 Y51 300 W £k

(4). Ak Hardware, Z3fifEPFECE S, SHaE 1.1.4 PR,



[0 H¥ Config — [SIMATIC 300(1) (Configuration) —— smpale udp] (=13
NEE

E“] Station Edit Insert FLC Y¥iew Options Window Help =]
D=8 § & Ll = Y
ke ol x|
Find: it o
Profil |[Stamdard ¥
L s
- ¥e® PROFIEUS-Fi
+- 3% FROFINET I0
+-[fl] SINATIC 300
+-[fl SIMATIC 400
+ SIMATIC PC Based Contral
+- B SINATIC FC Statien
< | =
FROFIEUS-IF slawes for £,
SIMATIC 57, M7, and CT —
¥ | fdistributed rack)
< | >
Press Fl to get Help.

1.1.4 R AR

(5) TEiZA T 4T 300 IREPF & S IR BEAIIC B e . e Ml e 24
HIERE—> S7-300 M4, WS, FIFFEEZAM I —ANSC 48 e,
1.1.5 fT7No

Find: it ohj

Profil |Sta.ndard ﬂ

+ %?- FROFIEUS IF

B2 PROFIEUS-FA
+ X FROFINET IO
= SIMATIC 300
+-]cT
+-{_7 cP-300
+-{_7] CPU-300
+-{_7 Fm-300
+ D Gateway
+-{_7 IM-300
+-{_7] MT-EXTENSION
+-{_7 Fs-300
-7 RACE-300
= [
+-{_7 Sm-300
+ SIMATIC 400
+ SIMATIC FC Based Contral
+- 8 SIMATIC FC Station

Liu o BCCn I e o Y T (N

—_
]




K 1.1.5 NS 2e

(6D CHUEFELUG, e SCAEREE — 4T CREAFBE& KRB INAE2E — AT, T
SESCHRIN,  BRIAE P R AR AT, WRANE AR AT, ARSI I SR
SRIGAEATIN A B A A Pk 5 — > 300 (1) CPU B, X HLZE P L CPU 315-2 DP
6ES7 315-2AH14-0ABO. Hi T ULAEM 2 uDP Mf5E /72, PIUEATZ7s N DP
P2, BIAERH R S e R e e BT . Gl 1.1.6 TR

Properties — PROFIBOS interface DP (ROfS2.1)

Geteral Parameters ]
Address: g - If a zubnet iz zelected,
the next_available address is
Subnet:
Hew. ..

K 1.1.6

(7). miii oK G, 7E3CZ8 Bt Il —A cPU 45 T, Wik 1.1.7 FioR.

== (01 UR

CPFU 315-2 IF
frly

Kl 1.1.7



(8), ARl SR MSEIUAT, ARJEAEA IR HE] CP 343 Bk, Wi 1.1.8
N

- 5% FROFIEUS TF
B FROFIEUS-FA

B PREOFINET IO

=[] SIMATIC 300

D CT

=3 cP-300

D AS-Interface

L——_Hj Industrial Ethernet

=] CF 343-1

(] BGET A43-1EXO0-0XED
(] BGET A43-1EX10-0XED
(] BGET A43-1EX11-0XED
(] BGET 345~ 1EXE0-0XED
= BGET 343-1EX21-0XED

¥i.0
i1
1.z

.77 BAET 2471 FYRN-NYEN

Kl 1.1.8

(9). il CP 343 ¥4, SHwiE 1.1.9 BRI, 7615 Akl thh
New.. %4, BHrat—ANLUKM LS, SRJG7E IP address H1 5 AN CP 343 1) IP Hiuht,
Subnet mask 5 N CP 343 [ MM (—R M ERIAED .

Properties — Ethernet interface CP 343-1 (R0S54)

General Farameters |

[ Set MAC address / u=e ISD proteocel

| 0 If a =ubnet 1= selected
MAC addr : s
Ak address I the next awailable addresses are
suggzested.
[¥ IF protocol is being nsed
Fat
IF address: [taz 168 0.1 Gt
¢ Do not use router
Subnet masl: |255.255.255.|:|
{7 Usze romter
Address: 192 165.0.1
Subnet:

Hew. . . |

Properties. .. |

Delete |

ok | Cancel |  Help |

1.1.9




(10). IP ZEld & 5 a, 45K 1.1.10 fros.

Propertiesz — Ethernet interface CP 343-1 (ROf54)

General Parameters ]

[ Zet MAC address f nsze IS0 protocol

MAD addr . If a subnet 15 zelected,
Bl meses | the next available addresses are
suggested.
—
Gat
IP address: 192. 185, 8. 180| FhEWER
i* In not use router
Subnet maslk: |255. 255.255.0
i Use router
Addrezs:
Subnet:
-—— not networked ——— Hew. .. |

Properties. .. |

Delete |

Cancel | Help |

Kl 1.1.10
(11). AegErsh oK %4, EHECE Stm, sbhy, FEZZehaSHE—/ > CcP 343
Mg, WE 1.1.11 fis.

== [0) UR

CFU 315-2 IF
i

I cr 3431

Kl 1.1.11

R B EBERAISE R T CPU (AR AL L



1.1.2 A E

(D), AR E 52 5, 7E SIMATIC Manager 1, #£$% Options->Configure
Network, 41 & 1.1.12,

QSIIATIC Nanager — [343_0DP —— C:\Program Filez\5iemenz\StepT

BB File Edit Insert FPLC Yiew NASESSH Hindow Help

= gT Customize. .. Ctrltilt+E
- % 343 UDFE a hecess Frotection P =
SIMATIC 300010 Change Log »
Text Libraries »

Language for Diszplay Dewices. ..
Manage Multilingual Texts ¥

Beference Data r

Configure Hetwork

Configure Process Diagnostics

Chx Data L4

Set PG/IC Interface. ..

K 1.1.12

(2). FTIF MLt & 5, se/citfidy CPU 315-2 DP, #RJGiEFE Insert->New
Connection, 1 1.1.13 iz,



‘.}%HetPru — [123 (Network) — C:‘Program
%@ﬂetwurk Edit BEAGES FIC Yiew Options Hindow
= E § 5 Hetwork Objects Ctrlts

Fthernet (1) Hew Commection... CtrltH
Industrial

e e ) 2
MPI (1)

MFI

SINATIC 300(1)

Kl 1.1.13

(3). H.ii Insert->New Connection J5 &5t an & 1.1.14 Fros g 5, 7EiX Bk
# Unspecified, 7E R Type 1 FH72ZR 1 EFE UDP connection, JE+F)5 2o

Bl Apply #2241

Insert New Connection rs_(|

Connection Partner

= @ In the current project
=-£p 343_UDF
e [mspeci fied)
-~ $1]1 broadeast stations
wee $11 multicast stations
% In unlmown project

| E

Station: [(rnspecified)

Connection

Type:

K| seely | Cancel | Help

K 1.1.14




(4). fidi Apply Jo, AIRESS i —ANE 4], %A d ok Bim] . inf&d 1.1.15
TR o

Insert New Connection

—Conmection Partner

B- @ In the cwrrent project
=8P 343 me

------------ (nspecified)

------------ #l]l broadecast stations
------------ A1l multicast stations
..... % In unkmown project

Inzert New Connection (2443:172)

possible.
Flease check any router addresses, 1f
required.

' Connections beyond subnet boundaries are
L)

Help |

Module: I

Connection

Type: IUIIP conmectlon LI

[¥ Display properties before inserting

ok | apsly | Cancel | Help |
K 1.1.15

(5 e Ja, I 1.1.16 541, X HLIESE 1D 24 10 (AME X0,
SR G IEHE Address 1T, 1 Address 3810 H S5 08 A5 e 25 1 1P Hivhik g 114556
a) AHLE A K5 F 5 VG o 1025~65535, ERIACKh 2000, AT
PLA OB, X HLBRIAE R 2000, IU37 M FH I T 28 E i o AR
]
b) H B A 45 11000 (%3 1 i PECS000 ¥R5E, S (KI5
SRS — K 1)



Nl E5ESHUG, B AT OK $#2H BT . HARSEN & WL 1.1.16 A1 1.1.17
i

Properties — UDP connection rX|
Options ] Owerview ] ]
Ganeral Information l .@ ]
Local Endpeint BElock Parameters
Il (hex): 1 —Itmn
Hame: \DF tiond
. 0P connection #15#0100 —|LADDE
Via CE: ICF 343-1 (RO/S4)

Eoute. ..

1.1.16

msert New Connection l&

Conmection Fartner
e

Propertiez — UDP connection

Options ] Owerwiew l ]
General Information Addresses

Forts from 1025 through B5535 are awailable.
{For further ports, refer to online help)

Local Eemote
IF (dec): 192, 165. §. 1580 192, 165, 5. 200
PORT (dec): 2000 |11000|

[ Address assignment in block

Cancel | Help |

0K | apply | Cancel Help |

1.1.17



(6). BLESERUG FE% M4 Bl E 3] PLC H1.

1.2 HERE

6 P I S, 45 DU R BIFE, {# ] FCS A FCe Bzl PEC5000 4%

IR v X Hd

REEAPF I R A 2% T VAR I A IS

LAR A g R N 2o

XL G FE S AE 0B1 HLSCHLIY, S Br B I I AT RERE SRR AL B . B

FUE 1.2.1 FE 1.2.1 s,

fetwork 1HNERSEF

Comment:
FC5
i SEND
4% SEND”
EN ENO
1 1
MO, O — ACT DONE  |-M0. 2
10 0
10— ID ERROR  |-M0. 3
1620100 1620000
W#16#100 — LADDR STATUS  |—Ir2
FAM 100.0
EYTE 12 - SEND
12
12 —-|LEN
1.2.1
FC5 52 M5 N W F £ 1.2.1 FToR.
*£1.21
ZH | BmRA | wlRERIBUE i
MACT=1I, MSEND Z¥d5 & ML si i
X VR IELEN AN
ACT | INPUT | BOOL 0,1 PCPIORLEN A s ‘
15 DONE. ERROR FISTATUS
D INPUT | INT 1764 (S7-400) ESHID HIeEIERENIERE.




1716 (S7-300)

i STEP 7 HW Config ZHACP I, #ibh

LADDR | INPUT | WORD FEHLE 4 Hh P gtk BoRE A AR . AR iR 1%
ok
A E7 T R s he o =AY 7 1R N VA S W
SEND INPUT | ANY R A BE | o g X
© HdEEX
TR I AN NS X RE ) EH
Al BERIBUE G 91 FSEND S 8rhs &
K.
< IR B,
ZE1SO AE4Al - XFS7-300
1S0onTCP/TcP | FC AG_SEND A ¥ffit £ 4£3%8192 #45 (X
e 1. 2...8192 | TUDP 42048 ) .
(B(SEND Zeggdfy | - MTSTH00
5 JHIIFC AG SEND, %k [X R A4 £ % 240
LEN INPUT | INT WK ) e
ZEUDP F. 1. TETERST-400 19 R 4110
2...2048 ( % o JE IR B SR A T RE
SEND % ¥ fi ¢ | TIB 00240 7 H L S e oKk
(I RE” ) TEAFIPERE | XTEATAT 44 N EEH, 5
B < I (- O~ B S
(AG_SEND/AG LSEND) »
* ¥ T-AG_SSEND, Reicds X B il ok fe K
1452 AN
0: AEMAL TGS | 2RSS EIR ST T e AR,
DONE | OUTPUT | BOOL W& HZIDONE = 0, AR ILEE. 78
I: AR SEe | B2 —TUHELI, CPRDONET & 40,
ERROR | OUTPUT | BOOL 0: - . A
1: iR
STATUS | OUTPUT | WORD REAH

HARRE S ST BB T i




Comment:

EN

101D

PN
1211.0
BYTE 100 —EECY

FCE

A: RECEIVE
"G _RECTY

W#16# 100 — LADDR

ENo
1
NDE |-Md. O
0
EEFOR |-N4. 2
1620000
STATUS |-MWE
45
LEN |—-Mws
K 1.2.2

FC6 $52- M5 I BRI 38 1.2.2 Fios.

*1.22

7 1]

pCTEN

] REFIEUE

B

INPUT

INT

1764 (S7-400)
1716 (S7-300)

FEID S HU P 10 ALk Bt 1%
HH

INPUT

WORD

BBk 46

TERLSTEP 7 HW Config ZHASCP B, HH
e b R PSR . IR
SE iz

RECV

INPUT

ANY

Fi 5 Huhk R

HAE DX [ HhE 35 )R B PN
© fEfEARALIX

© HEHx

KR = 0

W HLUEIERECY SO BE B IR A 212
FAT, WA IE BRI S AN R 212
FATHS, PERER 1 2 G .

FTFC63 AG_SRECV [RyE . T
FC63 AG_SRECV, UHZKGRECY AR
Pl 2 X KB, BN1452 7. 50,
TEHLOIE DL T 2 L R AR R
NDR=0; ERROR=1; STATUS=8185H

NDR

OUTPUT

BOOL

0: -
L: SHrE

SRR T T .




ERROR | OUTPUT | BOOL 0: - BRI

1: 5%
STATUS | OUTPUT | WORD RSN
HARRERT S WG )11 B)
LEN OUTPUT | INT TEISO AL 4 Al Faae INLUKIICP #5252 177 85, K ot
1SO-on-TCP F: | A%
178192 B A,
{EUDP | T R
172048 o XFFS7-300

FC AG_RECV [¥)24AThA feiF ik 2 4% 1%
8192 FT5 (HFTUDP k2048 F7) .

o % TS7-400

WIEFC AG_RECV, K £t X BRI A e 2
240 75,

WIFFC AG_SRECV, ¥ £t X BRI A e 2
1452 F75.

U FTH R AT S, K%, LADDR 51 S 2 T E 41 R DP 343
fkgatl, WilE 1.2.3 Jizs. SEND A A IREHE X I, X H & MB100 FFAG )
12 M

fEgfce, LADDR FIRIEH R C—FF, RECV i iX 4k

:l:l m VR

O address

ik cP 3431 BGHT [V1.1[3 qw

-'IEI'-‘LI'I-I‘-‘-U.'I?EM

1.3 FE R

SERCT SRR MOD RS, WAl DO AT IE R IS S S 8RAE T .
FEATHAR S I, /&2 TR A2
(1), It UDP IAEHE 4 M bRtk ModBus UDP WM, (EHEATHSCR N, 7 227 A% 44 I




ModBus UDP 3% X dE . i, 300 752U ModBus Mkl 2336 (0x0920) FHih
[y 12 AN, IR B4 %404 00 00 00 00 00 06 01 03 09 20 00 0C. %41 K Hhfd— {7 KR 1K
BN R 1.3.1 Pon. K&, BEESAUR N ModBus HuUlk (154 & 1145 300,
JORBARE LA 1.3.1 PR,

#1311

00 (00O |00 |00 |00 |06 01 03 09 |20 |00 0oC

i}
o
><4

HEE o BIA], s T | B ) % | ModBUS 12 | ModBus | BRHR AN 4L,

AL | A | A Huhl: DS SE A

‘.g Address | S:rml:u:\l| Display fnrmatl Status value| Modifyr wralue
1 ME 100 HEX EB#16#00 B#16#00
| B 101 HEX E#16#00 B# 16400
3| ME 1oz HEX EB#16#00 B#16#00
4| 1B 103 HEX E#16#00 B# 16400
5| ME 104 HEX EB#16#00 B#16#00
E| MB 108 HEX E#16#06 B# 16406
| ME 106 HEX E#16#01 B#16#01
s | MB 1o7 HEX E#16403 B#16#03
3| ME 108 HEX EB#16#02 B#16#09
1| MB 109 HEX EB#16#20 B#1e#20
1| 1B 110 HEX EB#16#00 B#16#00
12| B 111 HEX E#16#0C B#16#0C
PR B — |

K 1.3.1

REFEEENE: Rt A MB1211 THG, ILrh el 3B 9
AFATIRSCL, Bl SE B 2 1 As At MB1220 JT4R . B K/ 2t
SEBR R LK

1.4 R

U AR RGE AR, T et LU L5 T P«
(1) TG 1P HhEEE R
(20« Tl AR A s A8 s
(3D MBS FRIEAF 3 5 PEC A% IR FA—2




(), TP d R 1D STEE 1) 1D A—3L;
(5). RIERR A A4S Modbus UDP WML IR FRAERS 5

2. CPU315-2 PN/DP %! 5% UDP jE{E

{2 A% PN #) 300 5 PEC5000 {5 I, 75 2214 ] FB63, FB64, FB65, FB66
He,

21 ZHWE

2.1.1 W&

(1) T5CAE step BT —A4> 300 9 LR, Wik 2.1.1 Fios.

New Froject @

User projects lLibr:aries ] Multiprojects
Hame | Storage path -
%Uabﬂ C:\Program Files'Siemenz'StepThsTpr
%123455 C:\Program Files'Siemenz'StepThsTpr
£ 123458759 C:'\Program Files'Siemens'StepThsTpr
£ 1234587591 C:%\Prozram Files'SiemenshStepThsTpr
%258 C:%"Program Files'SiemensiStepThsTpr
%SZE\SE C:hFProgram Files'SiemenshStepTisTpr ¥
< | *

-

Hame: Type:

|5mpale_}.1d1:u |Pr-:-_ier_-t ﬂ

[
Storage location
|C: "Frogram FileshSiemenzh3tepThsTproj Browse. . . |

Cancel | Help |

Kl 2.1 Brad TR

(2, mhitfie fa, S HI—N R TRESCE, AFREDA smpale_udp, WKl 2.1.2 iR,



.! SINATIC Manager — [smpale ndp — C:%

%Eile Edit Insert PLC View Options Window
D & | 80 0 % 2
D R Object name
BENET (1)

212 T4

(3D B WARIE LRES b, s, 78 T2 H 3 FIEFE Insert New Obiect->SIMATIC
300 Station, ZcfmiidiLAE, o HIL—A 300 [ascul. WA 2.1.3 PR,

w [ Dbiect name | Symbolic name

Inzert Hew Object SIMATIC 400 Station
FLC SIMATIC 300 Station

SIMATIC H Station
SIMATIC PC Station
Other Station
SIMATIC 35

FiG/FC

Rename F2
Object Froperties... Alt+tRetwrn

MFT

FROFIEUS

Industrial Ethernet
FTF

ST Frogram

MT Frogram

+ % smpal e_ndp Object mnams = % smpale_udp
eI (1) SIMATIC 300(1)
[T

Kl 2.1.3 %00 300 BEA& Uk

(4). Xili Hardware, 2 9futh A8 AFRCE S, SimuniE 2.1.4 Fior.



B H¥, Config — [SINATIC 300(1) (Configuration) — sapale udp] (=13
N

E“] Station Edit Insert FLC Y¥iew Options Window Help
D=8 § & Ll = Y
ke ol x|
Find: it o
Profil |[Stamdard ¥
R \drriss o)
- ¥e® PROFIEUS-Fi
+- 3% FROFINET I0
+-[fl] SINATIC 300
+-[fl SIMATIC 400
+ SIMATIC PC Based Contral
+- B SINATIC FC Statien
< | =
FROFIEUS-IF slawes for £,
SIMATIC 57, M7, and CT —
¥ | fdistributed rack)
< | >
Press Fl to get Help.

Kl 2.1.4 PRSI

(5) fEiZFH FREAT 300 IHE1F B A e PR B e . 0 JeAE A MBS PP A
S7-300 1322, XiFT I, $THF /a4 ZeMml I —AN 238K e, il 2.1.5 Fos.

—
Find: it #hi
Profil |Sta.ndard ﬂ

+ %?- FROFIEUS IF

B2 PROFIEUS-FA
+ X FROFINET IO
= SIMATIC 300
+-]cT
+-{_7 cP-300
+-{_7] CPU-300
+-{_7 Fm-300
+ D Gateway
+-{_7 IM-300
+-{_7] MT-EXTENSION
+-{_7 Fs-300
-7 RACE-300
= [
+-{_7 Sm-300
+ SIMATIC 400
+ SIMATIC FC Based Contral
+- 8 SIMATIC FC Station

Liu o BCCn I e o Y T (N

—_
]

Kl 2.1.5 b 4e



(6)+ SCHGEFELL)E, KB SZER S AT (MR e KBS INAE S AT, ofr e S 2

I, BRI PR 2 —

ASe —— S

17, WRANE RS AT, AEISINBER N SR RIREA M e

FErpIERE—> 300 1) CPU U5, X HLBEFEMJE CPU 315-2 PN/DP 6ES7 315-2EH14-0ABO.

= SIMATIC 300
w1 CT
+-(_7] cP-300
—-1-(_7] cPU-300
+1 (7] cPU 312
+[_] CPU 312 IFM
+[_] CPU 3120
+[_] CPU 313
+-[_1 CPU 313C
+-[_1 CPU 313C-2 IP
+-[_1] CPU 313C-2 PP
+-[C1 CPU 314
+-[_] CEU 314 IFM
+-[_] CPU 314C-2 TP
+-[_] CPU 314C-2 PP
+1 (7] CPU 315
+ (] CPU 315-2 IF
-] CPV 315-2 PH/IF
+-(_] BEST 315-2EG10-0ARD
+-(_] BEST 315-2EH13-0ARD
-] BEST 315-2EH14-0ARD
+-[_] CPU 315F-2 IP
+-[_1 CPU 315F-2 PH/DP

+-[_]] CPU 316
ol e Tl AT TR 0 Y

K] 2.1.6 CPU Ik $¢

(7). MitiiZ cPU, S5 DOKMACE S, Wik 2.1.7 fizs.

Properties

Geaneral

IF address:

Subnet;

Subnet mask:

PR-I0 (RD/S2.2)

— Ethernet interface

Farameters l

If a subnet 1z selected,
the next awailable addresses are
suggested.

Gateway

197 168,01
|255. 255, 255 0

* Do not uze router

(™ Use router

Addres=:

Hew. ..

Deleta

Cancel | Help |

K 2.1.7 DIOKBC & S i

(8). fERX AT B A M LUK S HICE . B Adr New..., x5t NFm, £
S LR AR S P B R E B RT S 4 5E JS LE Subbet T I & 1 alias HHEL AN 19 2%



1F IP address Fl Subnet mask &5 C & — F 1P Huhb R HEEIS(E S, Wik 2.1.8 FizR.

Properties — Ethermet interface PR-I0 (ROf52.2)

Gemeral Parameters ]
If a subnet iz zelected,
the next awailable addresszes are
suggested.
Grateway
IP address: |192. 165. 8. 180
f* Do not use router
Subnet masl: |255.255.255.D
i~ Use router
Address:
Subnet:
-—— not networked -——
Froperties. ..
Telete

0E Cancel | Help |

K 2.1.8 LIRS HC S

(9 miiffiila, FESCO o LT LUK KLE 410 315 BE4% 17, WilE 2.1.9
P o

Ethernet (1): PROFINET-IO-System [100]

= (0] R

CFU 315-2F

2.1.9 FCE SERNT 315 W%

-

ML PA ) 9 AN RS T 300 FRIAEA I B ERATE



2.1.2 RERE
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= % smpale_udp Object name
—-[@ SIMATIC 300(1) ESysten data
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- ST Program(E)
@ Sources
Blacks
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SIS
Wizard for the Open Communication via Industrial
Ethernet

This Wizard helps wou to create UDTs for
communication DEs or DBz self used for the Open
Communication wia Industrial Ethernet.

Open Communication Wizard

Click "Hext *>* to continue the wizard.

Further informations on the Open Communication
wia Industrial Ethernet can be found wia the
followings links as well as in the manmals of the

used components.
Wizard readme file

Marmal “System Software for ST-300,/400 System
and Standard Functionzs” (Intermet]

Download “Wew components for open communicatiaon
over Industrial Ethernet” (Internet]

SIEMENS FAQ “ST-300 CPU 31x - Configuwing and programming
communication — Configuwring PROFINETinterfaces” (Int

[ Comcel | < Brevious Finish
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(3). fEK 2.1.15 TPIEFEHT L step7 T H DL #AR, midi b—2.

Open Communmication Wizard

F 7 project
STEF ¥ project and bloc

STER T PrDjEEt|C:"LPrng;ram FilezshSiemenzhStepTh=Tprojismpale u | E]

Block folder! |smpale_udp\SINATIC 300 (1)\CPY 315-2EW/DF\ST Progran (2)\BL

IF Adress of station found

[ < Previous ” Hext > Finizh
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(4), fEHPLAI T 2.1.16 TPIEFE New, fiili B2,

Open Communication Wizard

Upload connections

Remote IF

I [1B6%. .. DE/UDT Connection ... Conmectlon name
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Hext > | it =

(5) 7Eg iy 2.1.17 Ui, EFE uop B, fidhE R 2P,

Open Communication Wizard

Connection type

Chooze the type of wour connection.

() TCP native

Open, conmection—oriented communication as per BEFC T93.

(0 1S0 on TCP

Open, conmection—oriented communication as per RFC 1006

®:

Open,

connectionless communication as per BFC TES.

Finiczh
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(6). fEE 2118, midi b,

Open Communication Wizard

sommunication Partners

YWhich communication parter would you like to configure?

Communication partner A Communication partner B

ST-300 or ST-400 Inspec. conmectlon partner

[ < Prewious ]" Eext > " Finish
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a) Connection ID >4 300 [ ID 5, RV TFEEAT OP BIEHT, TEELEEFE—
MID 5, &4 upP BIFHAXT N —ME—K ID 5, AREH;

b) Connection name Jji% UDP EHE 2% (44 Bk, HIF AT LLE CE X, i3] — A
WRKER:

c) 1P address Al fE A 1P Hihk, ATH] UDP BN 75 EEACE B 1Ptk
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Open Communication Wizard

~ommunication Partners

Enter the properties of the communications parthners.

Communication partner A Communication partner B
Connection IN: W#lﬁﬁ |:|
Conmection name: |EPU315-2 FH/TF |

Connection establishme:

I:l Broadecast commection

[000}{008}|soo} |soo) 1s2}{168}/s | /204

Used interface: |Integ:rated (3155 v|

L9/ [7] [/ [9]
L9/ [3] [l [

[ 4 Brevious ][ Hext > ] Finish
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(8). TEHILR S A, MeE Mo 1. 1X 5 A KR 300 324 10 1, B 3R~ M
WA MG, Wi 2.1.20 fT7s . Communication partner A 1] JH ¥ 1 24 2000~5000,
Jra] DL PR A R A N ;. Communication partner B 17 % 5 DCCE 4% 1) 3 111

SXFN, DCCE ¥ 443 I & ALK 2.1, X HL PEC5000 1) 11547 11000.

(Open Communication ¥Wizard

-onnection parameters

Enter the parameters for the connection.

Communication partner A Communication partner B

Local port ne:

&I zooo | 11000 |

ST | | |

4 Previous ][ Hext > Finish
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(9. dHRCEENRE, S F—2,, SHIE 2.1.21, 7EXE, KEEEHNSHAT
fis 2] uDT Py, LS —DNEEIRIERSEL B MR 2 . XI5

74 UDT1 F1 UDT2.

Open Communication Wizard

se destination project

: 1 which STEP 7 project the blo all be compiled?

STEF T prl:-_ieu:t||::"LPrl:-gram FilezhSiemenzshStepT'sTprojhempale_u | E]

Communication partner A - Block for the connection data
Hame: 1IT1 [abzolute or =ymbolic, eg. UDT BS or “TCON_FPAR™)

Block folder: [smpale_udp\SIMATIC 300 (1)\CPU 315-2PN/DPAST Program @) | |- |

Communication partner A - Block for the address data

Hame: UDTZ| (abzolute or symbolic, =g UDT BR or “TADDE_FAR™

[ < Previous ” Hext > Finizh
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(10). YUl ErEEANC B e s, A S T 20245 . 4505, 76 SIMATIC

Manager 12> 81 UDT1 A1 UDT2 Be. @il 2.1.22 FioR.
= @ =mpale_udp Object name

=@ SIMATIC 300(1) ESSysten data

- CPU 315-2PH/DP 43.031 ...............................
- @ ST Program(2) {0 DT

@ Sources o DT
Elocks
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(1), 7E SIMATIC Manager A= e A7 8k, 8 R 7512 ik $¢ Data Block, 7%
M. Bret—~ DB, Wik 2.2.1.



@S}'stem data -—= -

{F0BL
{3 1UDT1 STL
3 UDTZ STL

Insert Hew Object Organization Bloclk
FLC r Function Bloclk

) Function
Rewire. ..

Data Blael
Compare Blocks. ..

Data Type
Variable Table

Reference Data b

Check Flock Consistency. ..

Frint r
Object Froperties. .. 81 t+Retwrn
Special Object Properties r
OC Wizard
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(2D BB DB By 44 0 DBL, AUHHTHF, #in—ANHiifA2 & DB_VAR, A &2k
UDT1. i 2.2.2 frow. $&AHIAN W 58— DB2, fE DB2 H1ii—-~F 1 DB_VAR,

2575k UDT2,

A LAD/STL/FED) — [DBl —— smpale udp\SINATIC 300/(1)\CPU 315—2PK/DF]

{F File Edit Insert FPLC Debug ¥iew Options Yindow Help
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= Addr iti
esz (Hame T¥pe Initial
0.0 STRUCT
+- 4 Libraries L0 |DB VAR
=64.0 END_STRUCT
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= ‘“ Libraries

+-§gs SIMATIC_WET CF
+-§g stdlibs

-6 Standard Library

+ Mizcellaneons Blocks

0 O O R

TI-5T Conwerting Blocks
FID Controel Elacles
IEC Function Elocks
Swy=tem Function Elocks
55-5T Conwerting Blocks
Organization Elocks

= Communication Elocks
ik FEG  USEND  CFU_300
ik FE9  URCY  CFU_300
{FFEIZ BSEND CFRU_300
{FFE1Z EECY CFU_300
{FFE14 GET CFU_300
ik FEIS  FUT  CFU_300
{FFEX0 GETIO  IO_FUHCT
{FFE?1 SETI0 IO_FUHCT
{F FEZZ  GETIO_FART  I0_FUHCT
{F FEZ3  SETIO_FART  I0_FUHCT
{FFEEZ TSEHD COMM
{FFERL TECY  COMM
{FFEEE TCOH  COMM
{F FERE  TODISCOH  COMM
{FFEET TUSEHD  COMM
{FFEEE TURCY  COMM
{FFEZI0  S5FW_TCF  COMM
L TToan CETW TOT o
K223
W iR AR E IR
a) FBG65, A IEH, Wi 2.2.4.
He twork 1 Bttt
Comment:
DES5
“TCON”™
EN EN0
Mo, 0 —4REQ DONE MO, 2
Wi16#1 —ID BUST MO, 35
P#DE1. DBED ERROE MO, 4
-0
DELl. DE_VAR —mCONNECT STATUS —NMW2
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FEFFH 5 | W2 2.2.1.

b)

% 2.2.1 FB65 5| i B

T4 51 e

REQ BT AR S S IR

ID UDP IE$% ID, SFERLE T EH ID 55
CONNECT AR R UDTL IR0 0% 2

DONE LI, FERSERET

BUSY N LI, IEAERENERE

ERROR LI, AT A

STATUS R REAAS, I %G| A bR A

Hetwork 2Heiaty

FB67, UDP kiXtk, wWifd 2.2.5,

Comment:
DBST
“TUSEND”
EN ENQ
Md. O —REQ DONE |-N4. 2
W#la#l —ID EUST |-N4.3
12 -{LEN EEROR |Md. 4
P#M 100, 0 STATUS HMwe
BEYTE 12 qDATA
FE#DE2. DBED
.0
DEZ. DE_VAR —ADDE
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%222
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c)

REQ T i O A ST

ID UDP %42 ID, S4ifEACE T ER) ID 55
LEN FIBHHE 1t KA

DATA I B 1) XA

DONE LI, ERGEAEAL

BUSY AR, AR

ERROR LI, A A

STATUS e bEAD, T | A bR A

FB68, UDP #:litdk, 4nl& 2.2.6.

(8 e kil : Title:

Comment:
DEGS
TTURCY”
EN ENG
Ms.0—4EN_E NDE MS. 2
W#16#1 4 ID BUOSY HMS.5
20 —-{LEN EREOR [M3.4d
F&#N 2000 STATUS MU0
BYTE 10 —{DATA
RCVD_LEN ~MW1Z2
PE2DE2. DBED
0
DE2. DE_WAR —{ADDE
K 2.2.6
FEH 1) 5 | 6B LR 2.2.3,
%223
54 51 e
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ID UDP 4% ID, SeFERCE S ID 52
LEN P DA B

DATA FIRBHEIX

ADDR FIRAKFE R L HE 24

DONE LI, ERGEAEAL

BUSY AR, AR

ERROR LI, A A

STATUS e bEAD, T | A bR A
RCVD_LEN SEBR A B K

d) FB66, &L, K 2.2.7.

e twork dfeiaty

Commerat:
DEG6
"TDISCON”
EN ENO
M14. 0 —{REQ DONE  [-M14. 2
W#16#1 1D BUSY [-M14. 3
ERROR  |-M14.4
STATUS  [-MW16
K 2.2.7
FEFF AT B W3 2.2.4.
%224
514 S HBE
REQ TR A gl ST R
ID UDP 3% ID, SgmfEflE S H ID 53
DONE LI, HEERRIERE
BUSY AN, IEAERT R




ERROR

LI, AR

STATUS

AR, %]
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- % smpale_udp
- SIMATIC 30001)

Object name

Symbolic nam

@System data

- [@ crr 315-2PNIP | miiE

= ST Frogram (2)

(B Sources
Elocks

43 FEES
43 FEEE
&3 FEET

&3 FEES
{3 DE1

L} IEZ

L} IERS
{7} IEGG
{F IEBT
{F IEGS
kDT
i3 DTz
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TCON

TOT=CON

TUSERD
TURCY

SER T SRR TR T LLMEAT IR OB 5 A T
EMATECR S M, P T AT B2

(1), It UDP {5484 M hrvE ModBus UDP B, EHEATEHRISC RN, o B P 4ic I
ModBus UDP # SCk& A . ltn, ik 300 AR HL M ModBus Hilil 2848 (0x0B20) JT4f

() 4 A7, 53 % 2% %045 00 00 00 00 00 06 01 03 OB 20 00 04, %4 K H Hh&F— 7 £ 7m (7
XU 231 ffios. KikEELG, B&SIEN N ModBus Huik o i 84l A 0145 300, A
PO B 15 DL L 2.3.1 FHE] 2.3.2 s

%231
00 |00 |00 |00 |00 |06 01 03 0B [20 |00 04
BT o RIAT, TosEBrmi S | ROCH | B U5 W) % | ModBUS 12 | ModBus | BRI,




A | Al | e Huhk PLEE Ry BT
 MuuIEss | OZWLLL DispIay AUIWL| SUwius value | AOQITT Value
ME 100 HEX E#16%00 E#16#00
ME 101 HEX B# 16400 B#16#00
ME 102 HEX E#16%00 B#16#00
ME 103 HEX B# 16400 B#16#00
ME 104 HEX E#16%00 B#16#00
ME 105 HEX B# 16#06 B# 16406
ME 106 HEX E#16#01 B#16#01
ME 107 HEX B# 16#03 B#16#03
ME 108 HEX E#16%0B E#16#0B
ME 109 HEX B# 16420 B#16#20
ME 110 HEX E#16%00 B#16#00
ME 111 HEX Bt 16#04 B#16#04
ME 112 HEX E#16%00
ME 200 HEX B# 16400
ME 201 HEX E#16%00
ME 202 HEX B# 16400
ME 203 HEX E#16%00
ME 204 HEX B# 16400
ME 205 HEX E#16%0B
ME 206 HEX B#16#01
ME 207 HEX B#16%03
ME 208 HEX B 16#08
ME 209 HEX E#16#01
ME 210 HEX B#16#01
ME 211 HEX B#16%02
ME 212 HEX B 16#02
ME 213 HEX B#16%03
ME 214 HEX B# 16#03
ME 215 HEX B 16%04
ME 216 HEX Bt 16#04
ME 217 HEX E#16%00

ME 218 HEX
ME 210 HEX [::::::::::]
ME 220 HEX
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L] 0x0B20 (2548) BHESHFT 257 101 0x0101

i1 Dx0B21 (2548) BREFSHFT 514 202 0x0202
nz 0x0E2Z (2850 HEFSHFT 71 303 Ox0303
MK 0x0E23 (2851 HRESNETD 1028 404 0404
[T Dx0B24 (2852) HHSNFER 1285 505 0x0505
NS 0x0B25 (2853) BRFSHFTS 0 0
NHe 0x0B26 (2554) BRFESMFTD 0 0
MHT Dx0B2T (2855) HEFSHFTS 0 0
MHE 0x0E2E (2856 HRSNETD o o
K 2.3.2

fF BB 2.3.0 FIE 2.3.2 1, 1567 300 HLE A UDP K%l MB100 FF4RIH 12 A
TR RA 2 I 12 AT SO BN ModBus 3k 2848 JFAAIK 4 A>T
i ROXH LS, PECS000 2K izt i dls A ik 45 300, 300 JEid UDP FZHHR Rl 2
IR 708 21 MB200 JFAR L L. IX LB T 4 AN FR%E, oA 5 AMRcCk, ik
— AP . — AN IR EE, — AN ModBus ThRES LUK 8 N TFATIIEL
i, T AR 1 SR 16 ST

(2). 1% UDP iSRRI 1, ARE I — MRS

2.4 BRI

(1. WFRERART), EEEE NN P IR IEw, REEE— FRCE R
R 5B B

(2) EHARAHPRET IR 7000:  BERRIRASR R S RA 75 @ L ks, HiE
HOARES, AFRIRHR;

(3). FWHRA IR TR 7002:  SEMOIRASE R IELESEAT BcHs (i, Wik 300
FESZIN B RAEARSC R, T FRR AR IEH IS

(4). WARBEM IR, W22 MIABIT RS, RURZOIRAS, Bumt
A LAERT A e e, SR T IR I RIS AT, W] LE I A W i
RS SHe ) W e 2 15 1 Ty

(5D A1 2R 300 i ZEMI 22 A e 34T UDP A N, 300 i ZE A8 AN ) 11175, H. FB65,

FB67, FB68, FB66 i LT AMMIAHK. WK 2.4.1 fior.



Inzsert Function Block

": IThe object ‘FBES' already exists. Do you want

to overwrite 1t7

Bename. . . | Adjust Attributes. .. |
Yes | Ho | Help |
Rename | X |
From: IFBES
To FE|
o | rcamea |
Kl 2.4.1

(6), AHIRVU]T UDP A5 PRI HLE AT 2 WL [ 1 - HEORSCHF 1R UDP LB KA R 3C
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